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Seafloor Tutorial
This tutorial collection is specific to the Seafloor functionality in Geocap, however a few chapters are of a general
character and may be duplicated in other tutorials. Training data will be used as an example project, but other
projects may be used instead when doing the exercises.

The order of the tutorials is more or less describing the suggested order in which a real project would be done. In
this set of tutorials we will:
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A. Getting Started with Geocap Seafloor

Introduction

Geocap is a software for mapping and modeling geoscientific data, designed with focus on interactivity and
flexible control of visualization and manipulation. Geocap is operated through projects. The project "holds" the
data in a folder-like structure, similar to Windows "File Explorer". All datasets are "children" of either a folder or
another dataset. Geocap offers different project templates, giving you a pre-defined folder structure that fits your
workflow for a specific type of work. In this tutorial collection we are going to use the Seafloor project template.

Data visualization and manipulation is operated through commands. Commands can be used to display datasets
in the graphics window, manipulate existing datasets or to generate new datasets. The Geocap Sefloor module
offers a range of commands for processing hydrographic data.These commands are available from tthe Seafloor
Main Menu or if you right click a dataset or folder in the project.

All the project data is visualized in the graphics window and by using the mouse it is possible to pan, zoom,
rotate, spin, scale z-axis and so on.

This section will guide you through the basics of opening a project, explore and display the project data and
navigate in the graphics window.

Exercises

Start Geocap on Windows 7
Start Geocap on Windows 8.1
Set working directory and auto save
Open the Atlantis (Mini) project
Explore the project folder structure
Display data
Navigate using the mouse

 

 

Starting Geocap

Exercise

Start Geocap on Windows 7

On your start menu click Start > All programs > Geocap > Geocap 7.x.x - 64 > Geocap 7.x.x - 64

 

 

Exercise

Start Geocap on Windows 8.1

Go to the    .Start screen
Near the lower-left corner of the Start screen, click the arrow down and go to the  . Apps view
In the search field in the upper right corner, enter the text  .Geocap
All the files installed by the installation wizard will be listed. (It is also possible to find the
Geocap 7.x.x group without using the search field.)
Click on the Geocap 7.x.x - 64 entry to start the program.

-
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2.  
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User Documentation

Parts of the user documentation is found under the Help pulldown. There rest is found here: http://www.geocap.
. Read briefly through the documentation to get an understanding of what you can expect to find in theno/doc

documents.

The user documentations consists of:

User Guide with detailed descriptions of Geocap usage.
Reference manual with syntax and details of the commands in the Geocap scripting language.
Installation Guide with details on installation, dongle drivers etc.
Release Notes contains incremental updates and bug fix descriptions as well as major releases.
Articles is a collection of articles on various topics that still is not included in the documentation.
Tutorials contains thematic tutorials on products. The General tutorials mainly contains topics that are
put in a better context within the more specialized product tutorials.
FAQ is a list of Frequently asked questions, with their corresponding answers.

 

Initial Setup

Geocap comes with a range of settings which can modified to make it easier to work with. One of these settings
is the working directory which is the folder Geocap will open every time you browse for something. We will now
set this directory and we will also turn on auto save.

 

Exercise

Set working directory and auto save

Click Tools > Options
Click the  icon for thebrowse  Working Directory.
Select the folder and click Geocap1  Select folder
Click on Projects
Check the box Automatically save all projects at regular time intervals
Set the  to Time interval 5
Click OK

-

http://www.geocap.no/doc
http://www.geocap.no/doc
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2.  
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Geocap Project

The Atlantis project is built using the UNCLOS project template. This template consists of four main top level
folders; Maritime lines, Seabed, Sediment data and Outer limit. The maritime lines folder will hold all the data
that has no reference to depth or is located at the sea surface. The Seabed folder will hold all the data located at
the seabed, like bathymetric profiles, foot of slope points and so on. The Sediment data folder will hold all the
subsurface data like seismic, interpretations, velocities, sediment profiles etc. The Outer limit folder will hold all
datasets which is used to construct the outer limit. We are now going to open the Atlantis project and look closer
at this project structure.

 

Exercise

Open the Atlantis (Mini) project

Click  File > Open > Project
Browse to the location of the Atlantis_Mini project. ( )Geocap1/Projects/Atlantis_Mini/db
Select the  file and click . A window similar to the one below willAtlantis_Mini.db Open
appear.

An open project

 

 

  

Tip

Next time you can open the project by going to .File > Recent Projects
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2.  

Pressing the small triangles (or '+' in other Windows versions) to the left of a folder will display the folder's
contents. Datasets and folders are organized very similarly to a file tree structure. A folder can contain other
folders, or datasets.

 

   

The Geocap Project structure and data items shown in List Mode (left) and in Tree mode (right).

In the next exercise we are going to explore how the Atlantis project is structured. Taking notice of how folders
and datasets are organized. Datasets and folders can be cut, copied, pasted, renamed and deleted. This is
performed from the popup menu which appears when right-clicking a dataset. The right click popup menu also
contains   which may be executed on the datasets.commands

 

Exercise

Explore the project folder structure

Expand the different folders and observe the sub folders and datasets
Right click on folders and datasets and look at the right-click menus.

 

Note that there are two "modes" of the project view. Switch between these two by clicking on the tabs; Li

and .  view sorts folder content into a separate window, while  view sorts everything intost Tree List Tree

the tree itself.

A Geocap project is stored in a folder on your computer. The project consist of a   file, which".db"

contains information about the project tree, and several files which contain the data sets. You should let

Geocap manage the files in the project folder and should not store other files in this folder.

If you want to make a backup of your projects, or if you want to exchange Geocap projects with other

Geocap users you may zip the project folder with all the underlaying datasets into one file. This is

convenient for sending e.g. to .support@geocap.no
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Displaying Data

By right clicking a dataset a range of different visualization commands is made available. For each type of
dataset Geocap will have a default command. This is the command which will be used when ticking the
checkbox next to a dataset. We are now going to display the different datasets in the project using the default
command.

Exercise

Display data

Display the various datasets in the project

Locate a grid dataset (structured points or seabed) e.g. Grids/atlantis
Right click the dataset and select . This will make the display window center theZoom to Data
graphics window around the dataset.

Right click the dataset again and try a display command e.g.  , , Display Map Data Map
 or .sea Map land

Display some of the lines e.g. lines found under  by right-clicking and selecting theCoast lines

command  Display
Check, and uncheck the checkboxes to the left of the displayed items and observe that this
toggles displayed objects on/off. You can also check and uncheck the folders containing
displayed items.
Items can also be displayed double clicking on one of the commands in the Toolbox (Item,
Schema and Shared commands) 

-

Note that by checking and unchecking the first level folder , or  all datasets displayedCoast Lines Grids

under this folder are shown and hidden.
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Navigating in the 3D window

Now that we have displayed some of our data we can start navigating around the Atlantis continental
shelf. Geocap is best operated using a three-button mouse with a wheel, see picture below. A two-button mouse
or using the Touch-pad is possible but not recommended. Navigating in the 3D graphics window is done by
pressing one of the mouse buttons while the cursor is in the graphics window, and moving the mouse while
keeping the button pressed.

Rotate - Press left mouse button + move
Pan - Press middle mouse button (wheel) + move or Shift + left mouse button + move
Zoom - Press right mouse button + move
Scale Z - Scroll mouse wheel 
Spin - Ctrl + press left mouse button + move

The mouse buttons

Exercise

Navigate using the mouse

Zoom in close to one of the bathymetric profiles displayed by press  andright mouse button
moving the mouse upwards.
Pan along the seabed surface by pressing the  (wheel) and moving themiddle mouse button
mouse in any direction.
Zoom out again by press right mouse button and moving the mouse downwards.
Rotate the displayed data by pressing the  and moving the mouse.left mouse button
Spin the data by holding down  on your keyboard, pressing the  andCtrl  left mouse button
moving the mouse.
Now try to increase the  by  upwards.z-scale scrolling the mouse wheel
Move around the 3D model an practice these elements for a few minutes.

Tip

The focal point is the center of the display and the point of rotation. Change the focal point by

positioning the mouse cursor on a desired point in the display window and press the  key onX

the keyboard.
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B. Seafloor Main Menu (Extract from User Guide)

In this section:

Introduction
How to open the Seafloor Main Menu
The Content of the Seafloor Main Menu
Menu bar options (File, Edit, Help)
The Current Project part
The Working with Survey Data part
The Working with Charts part

Introduction

The   is a collection of commands and project properties in a Geocap Seafloor project. TheSeafloor Main Menu
most frequently used commands are accessible through this menu, which will make it easier for new users to
operate the Seafloor user interface. However, these and more commands are also available from the project
interface.

The Seafloor Main Menu.

How to open the Seafloor Main Menu

To open the   it is required that the   is loaded, and that requires that theSeafloor Main Menu Seafloor package
license file contains one of the features for loading the package. 
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The Seafloor package is loaded either on startup of Geocap, or on the   menu, click the   menu. InTools Options
the menu that appears, click  , and then select   in the right hand part of the menu.Plug-ins Seafloor

When the   is loaded, the menu bar in Geocap will contain a   pulldown menu.Seafloor package Seafloor

The Seafloor pull down in the Geocap menu bar

On the   menu, click  .Seafloor Seafloor Main Menu

Open the menu

Then the   is opened (see figure above).Seafloor Main Menu

For all actions in this menu it is required to load a project. If no project is loaded, the message "No project is
currently loaded into Geocap!" will appear. Then a description on how to load a project follows.

 

The Content of the Seafloor Main Menu

The   is divided in four parts, the  , the   part, the Seafloor Main Menu menu bar Current project Working with
 part, and the   part.Survey Data Working with Charts

The   has three options: File, Edit, Helpmenu bar
The   part contains information about which project is active, and what coordinate systemCurrent project
the project is using.
The   part is the interface to useful commands for processing survey dataWorking with Survey Data
through the   package.Geocap Seafloor
The   part is the interface to useful commands for processing chart data through the Working with Charts

 package.Geocap Seafloor

 

Menu bar options (File, Edit, Help)

The upper part of the menu is a menu bar with the entries  ,   and  :File Edit Help

The Menu bar

For the actions from menu bar entries, see below.

-
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File

New - Project... will open the dialog to make a new Geocap (Seafloor) project.
The dialog ends with a question about setting geodetic properties for the project.
New - Survey Data folder... will create a folder of type   from top level in the project.Survey
New - Charts Data folder... will create a folder of type   from top level in the project.Charts
The last two commands are useful if the project does not have a folder of the actual type, or if a more
than one folder of this type is required.

Open - Project... will open any existing Geocap projects in the computer or network.

Recent Projects will give a list of recently opened Geocap projects.

 

Edit

Geodetic settings will open the dialog for setting geodetic properties for the project.
Vessel Configuration Manager will open the dialog for setting vessel properties for all open projects.
This entry will have a meaning only when   are loaded.Multibeam Sonar data
Point Cloud (Multibeam) Editor will open the 3D editing tool for point cloud data (multibeam data) (Multi

). This entry will work both when   and   are loaded.beam Editor Point Cloud data Multibeam Sonar data

Help

Seafloor Main Menu will show the help dialog.
Seafloor User Guide will open the Seafloor User Guide documentation as a pdf file.

https://geocap.atlassian.net/wiki/display/ug/5.+Multibeam#id-5.Multibeam-MultibeamEditor
https://geocap.atlassian.net/wiki/display/ug/5.+Multibeam#id-5.Multibeam-MultibeamEditor
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Refresh Report Menu will open the reports dialog containing the last processing results, if it is closed or
hidden.

 

 

The Current Project part

The   part shows the   project in the  . In Geocap the user can loadCurrent Project active Seafloor Main Menu
several projects at the time.

The Current Project part

All projects are shown in the pulldown menu behind the text  . The pulldown and the the projectProject Name
information is is automatically updated if a project is closed or a new project loaded into Geocap.

The text   indicates that during import of any dataset into Geocap, the dataUsing geodetic settings on import
will be transformed to the project coordinate system. This action is set up in the   menu.Geodetic Settings

To change the coordinate system, find the   menu, and click  .Edit Geodetic Settings

The text   indicates that a coordinate system is defined, but noNot using geodetic settings on import
transformation will be performed during import.

The text   indicates that the project doe not have any coordinate system.No geodetic settings is defined

 

The Working with Survey Data part

The Working with Survey Data part

This part contains tabs for import, display and work with data typically from surveys. The three tabs are:

The XYZ data tab
The Multibeam Sonar tab
The Single Beam tab
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The XYZ data tab

The commands in the XYZ data tab are shortcuts to the commands on a folder of type  . Many of theSoundings
commands are  , which means that the settings in the menu is remembered for each folder.Item Commands

If there are several folders of the same type in the project, a dialog will appear.

The XYZ data tab

Import to XYZ data folder: This command will import data to folders of type  .Soundings

There is also a choice to use the   the   or the   reader.Generic reader, ASCII Column reader NaviModel DB

Display Soundings: This command will display the data in folders of type  .Soundings

Gridding Files: This command will make it possible to do gridding (terrain modelling) of the data in folders of
type  .Soundings

Show file properties: This command will show dataset name, bounding box and number of points of the data in
folders of type  .Soundings

Create XYZ data (soundings) Folder: This command will create a new folder of the type   as aSoundings
subfolder under a folder of type  .Survey

 

The Multibeam Sonar tab

The commands in the Multibeam Sonar tab are shortcuts to the commands on a folder of type  . ManyMultibeam
of the commands are  , which means that the settings in the menu is remembered for eachItem Commands
folder.

If there are several folders of the same type in the project, a dialog will appear.

The Multibeam Sonar tab

Import Multibeam Sonar Data: This command will import data to folders of type  .Multibeam
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Display Multibeam Data: This command will display the data in folders of type  . Also data set nameMultibeam
and navigation lines can be diplayed.

Gridding Multibeam Data: This command will make it possible to do gridding (terrain modelling) of the data in
folders of type  .Multibeam

Show Survey Line properties: This command will show dataset name, bounding box and number of points of
the data in folders of type  .Multibeam

Create Multibeam Folder: This command will create a new folder of the type   as a subfolder under aMultibeam
folder of type  .Survey

 

The Single Beam tab

The commands in the Single Beam tab are shortcuts to the commands on a folder of type  . ManySingle Beam
of the commands are  , which means that the settings in the menu is remembered for eachItem Commands
folder.

If there are several folders of the same type in the project, a dialog will appear.

The Single Beam tab

Import to Single Beam folder: This command will import data to folders of type  .Single Beam

There is also a choice to use the   or the  .Generic reader ASCII Column reader

Display Soundings: This command will display the data in folders of type  .Single Beam

Gridding Files: This command will make it possible to do gridding (terrain modelling) of the data in folders of
type  .Single Beam

Show file properties: This command will show dataset name, bounding box and number of points of the data in
folders of type  .Single Beam

Create    : This command will create a new folder of the type   as a subfolderSingle Beam Folder Single Beam
under a folder of type  .Survey

-
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The Working with Charts part

The Working with Charts part

This part contains tabs for managing, display and work with data organized in charts (areas of interest). The two
tabs are:

The Chart commands tab

The Utilities tab

 

The Chart commands tab

The commands in the Chart commands tab are shortcuts to the commands on folders of type   and onCharts
folders of type  . Many of the commands are  , which means that the settings in the menuChart Item Commands
is remembered for each folder.

If there are several folders of the same type in the project, a dialog will appear.

The Chart commands tab

Create and Modify Chart: This command will create or modify folders of type  .Chart

Extract Soundings: This command will read data stored below a folder of type  , and save the result asSurvey
a   data set in folders of type  .Soundings Chart

:Display Chart Data  This command will display the different data stored in folders of type   If there are.Chart
several   folders in the project, a dialog will appear.Charts

Gridding Chart: This command will work on folders of type  .Chart
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The command will read the   dataset and create a digital terrain model (DTM). The result will beSoundings
saved in the same folder as a   data set.Seafloor

Show Chart properties: This command will show properties of the content of folders with type  .Chart

Remove Chart Data: With this commands it is possible to remove specific data objects from folders of type Cha
. The command can be specified to  , rt Remove entire chart folder and data Remove specified chart folder

, or  .item(s) Remove empty chart

 

The Utilities tab

This part contains buttons with commands to show properties, display and export data in a   project.Seafloor
All commands work on folders on type   and on folders of type  .Charts Chart

If there are several folders of the same type in the project, a dialog will appear.

The Utilities tab

Export Chart Data: This command will export different type of data from folders of type  .Chart

Typical datasets to export are   and   polygons,   (points) and   (DTM).Frame Boundary Soundings Surface

Export Contours: This command will export   data from the   (DTM) data set in folders of type Contours Seafloor
. An option is to export as   instead.Chart Contour Areas

Merge Surfaces: This command will create a new   surface (DTM) for a chart by merging surfaces fromSeafloor
other charts in folders of type  .Chart

:Make Boundary Polygon  This command will create the boundary (outline) for a chart The boundary can be. 
created from the   (DTM) dataset or from the   (points) dataset. (Not enabled for Shelf.)Seafloor Soundings

Make Profile: This command will create a continuous depth profile (intersection) through the Seafloor (DTM)
data set in folders of type Chart. (Not enabled for Shelf.)

Points Classification: This command will anaylyze the Seafloor (DTM) data set in folders of typeChart. The
commands will create new points data sets of types  ,  ,  ,   and  . (NotShoals Deeps Ridges Saddles Valleys
enabled for Shelf.)
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C. Create a New Seafloor Project

Introduction

Geocap provide empty folder structure for various types of projects. This will give you a starting point to get
organized with your own project. A project template either gives you a ready made folder structure, or it gives
you a suite of folders to choose from.

Exercises

Generate a new and empty Seafloor project
Explore the project settings

The Seafloor project template

Geocap can provide an empty folder structure for Seafloor projects. This will give you a starting point to get
organized with your own Seafloor project. The default folder structure holds empty folders for most of the data
types you will need. If you do not find a suitable folder you can create a new folder for that data. It is also a good
idea to create sub-folders if you have a lot of data, for instance a sub-folder for each survey or for each region.

 

Exercise

Generate a new and empty Seafloor project

In the main menu of Geocap, click Seafloor > Seafloor Main Menu
In the Seafloor Main Menu click . A new dialog will pop up.File > New > Project
Select the  project templateSeafloor
Type in the name of your project in the  field. The name may consist of letters, numbersName
and spaces, but special characters like [, æ,ø, å, &, /, % ... should be avoided.
Click the  button, and select where you want to store your project on your hard disk.Browse
Click .Finish

You will now be prompted with a window asking you if you want to define the geodetic setting of the
project.

Click Yes
Check the  box and select  as datum and Use geodetic settings for project WGS84 UTM

 as coordinate system.Zone 32 N
Click OK

An empty project structure may be used for communicating relevant data to colleagues, or for analysis

and trouble shooting by us. To send parts of a project to us in Geocap Support, even only a single

dataset, you may copy the dataset (or a folder) from your main project and paste it into this empty

project. Then zip and send the disk folder .zip to projectname support@geocap.no

When enabling geodetic settings all data will be converted to these settings on import.
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An empty Seafloor project

Your project will now look like the image above. The idea is that this basic structure is kept. Folders may be
added and data imported, but the original folders should not be renamed or moved, and their schemas should
not be changed. This is because this folder structure is used when new datasets are generated. If an original
folder is not present, it will be recreated.

 

Exercise

Explore the project settings

Click the  icon on the project toolbar to look at the settings. Pay particular attention to Geo
. You can see that the settings you previously entered are stored here. You can alsodetics

access these from the Seafloor main menu Edit > Geodetic Settings
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D. Import Data

Introduction

Geocap supports a vast amount of Multibeam Sonar Data, in addition to Single Beam and XYZ data. These
types of datasets are imported in different folders in the  folder.1. Survey Data

Geocap also supports import of sensor files in ASCII format, like Tide, Navigation, Velocity, Gyro, Heave, Roll
and Pitch.

Exercises

Import XYZ data
Import Multibeam Sonar data
Show properties for the Multibeam data
Show properties for the XYZ data

 

Importing

Exercise

Import XYZ data

Click the  tab in the XYZ data Seafloor Main Menu
Click Import to XYZ data folder
Click Generic reader

Click the  icon and browse to the folder  on disk...\Seafloor_Course\XYZ\Simrad_xyz
Select all files and click Open
Observe that the  looks ok.File header/information
Keep the  as is.Schema
Click  and the import will start.Execute
After import a dialog will pop up, with information about the import. Click  on this.OK

You should now be able to see your xyz data files in the project folder 1. Survey Data / XYZ data

Imported XYZ files
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5.  
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Exercise

Import Multibeam Sonar data

Click the  tab in the Multibeam Sonar Seafloor Main Menu
Click Import Multibeam Sonar Data

Click the  icon and browse to the folder ..\Seafloor_Course\Multibeam Sensor
 on disk.Data\EM_710

Select all files and click Open
Keep the  as is.Import Options
Click  and the import will start.Execute
After import a dialog will pop up, with information about the import. This report will also be
available in the folder .1. Survey Data / Multibeam /Reports

You should now be able to see your multibeam files in the project folder 1. Survey Data / Multibeam

Imported Multibeam Sonar data

-

Read more about the import options by clicking the  icon on the import menu.

The different import commands are also available on the right-click menus of the  folder and Multibeam

 folder.XYZ data
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1.  
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Data properties

After importing it might be valuable to take a look at the properties for the files you just imported, to check the
range, number of points etc.

Exercise

Show properties for the Multibeam data

Click the  tab in the .Multibeam Sonar Seafloor Main Menu
Click . A window containing the properties will pop up.Show Survey Line Properties

Observe that the list contains a row for each file, with X-, Y-, Z-range and number of points. At the
bottom of the window you will see the total range and number of points for all files.

Showing Survey Line Properties

Exercise

Show properties for the XYZ data

Click the  tab in the .XYZ data Seafloor Main Menu
Click . A window containing the properties will pop up.Show Dataset Properties

Observe that the list contains a row for each file, with X-, Y-, Z-range and number of points. At the
bottom of the window you will see the total range and number of points for all files.

You can copy these properties straight into e.g. Excel. Just select a row, column or the whole table

(Ctrl+A), press Ctrl+C on your keyboard and then Ctrl+V in Excel.

These commands are also available on the  and  folders in the project. You canMultibeam XYZ data

also display the properties from within different command menus, i.e. Display Multibeam Data
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E. Display Data

Introduction

There are several ways to display multibeam soundings and XYZ data. XYZ datasets has the following display
commands available on their right-click menu;

Display
Display Points
LOD Points Display
Map Data

Multibeam Survey files has the following display commands available on their right click menu;

Display
LOD Points Display
Map Depth
Map Amplitude

In many cases you want to display several datasets together, showing the same range for all the files. The Displ
 and  commands in the  offers an easy interface foray Soundings Display Multibeam Data Seafloor Main Menu

displaying data objects together in different ways. These commands are also available on the right-click on the X
 folder and  folder respectively.YZ data Multibeam

Exercises

Display XYZ data (Soundings)
Display Multibeam data
Experiment with different display settings
Display filtered data

-

Level Of Detail (LOD) displays points and grids based on the current zoom level. This means that the

resolution increases automatically when you zoom closer, which makes the display of large point clouds

or grid a lot faster.
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XYZ Data

Exercise

Display XYZ data (Soundings)

Select the  tab on the XYZ data Seafloor Main Menu
Click Display Soundings
In the list of datasets, select the XYZ datasets you want to display and make sure the settings
are equal to the image below
Click Execute

You should now be able to see the soundings in the graphics window.

Displaying XYZ data

-

Selecting datasets works the same way as in a Windows file browser, which means you can hold down 

 or  to select several datasets, or use  to select all.shift ctrl ctrl + a
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Multibeam Data

Exercise

Display Multibeam data

Select the  tab on the Multibeam Sonar Seafloor Main Menu
Click Display Multibeam Data
Select the Survey Lines you want to display and make sure the settings are equal to the image
below
Click Execute

You should now be able to see the soundings in the graphics window.

Displaying multibeam data

Exercise

Experiment with different display settings

Make sure the  menu is open and that all survey lines has been selected.Display Mulitibeam Data
Try this:

Un-check  and click  - Observe that the soundings from each surveyUse color range Execute
line will have different colors

Set the  to  and click  - Observe that the points size increased.Point marker size 5 Execute

Check the  box and click  - Observe that the navigation line is nowShow navigation Execute
displayed.

Check the  box again and go to the  tab.Use color range Color Table
Check the  box, select  and type in the values  and .Use Color Table Absolute range 50 200
Click  and observe that the mapping range is between 50m and 200m.Execute
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Exercise

Display filtered data

Make sure the  menu is open and that all survey lines has been displayed.Display Mulitibeam Data

Click on the  button.Open Point Flag Visibility Filter

Notice that the flag  has been checked as  and that the flag  hasAll points Normal Deleted
been checked as Hide

Check the  box for the  flag.Color Deleted

The red points that are now displayed are points that were filtered away during import. This could be
because of missing navigation or that they were flagged as not valid by the multibeam echosounder.
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F. Basic Concepts in Geocap

Introduction

There are a few concepts in Geocap which are important to understand in order to work efficiently with the
software. The main concepts are  ,   and  These concepts willActors Schemas, Geodetic Settings Commands. 
be explained in this section. In addition to this section also talks about toolbars, color tables and keyboard short
cuts.

Exercises

Get familiar with schema commands
Change the default display for seabed surfaces
View the geodetic settings of a dataset
Change the color table on a seabed surface
Display data on the Sticky Surface
Try out the different tools on the toolbar
Try the different keyboard shortcuts

Actors

In display context an   is a graphical term for a visualization unit. A complex display is created by a set of actor ac
.   are shown as child's of datasets and are shown in blue text. In Geocap the basic principle is that ators Actors

display   creates one or several  . It is possible to remove the   and the associated displaycommand actors actors
by right clicking and selecting Delete

Visualizations are called actors

Schemas

By default datasets are organized into data types, such as points and lines (polydata), grids (structured points)
etc. These are basic geometric types that contain little information about the domain in which they operate. E.g.
coast lines, bathymetric profiles and boundary polygons are all lines (polydata), but the way we work with these
types of data are very different and so it is only natural to classify them into different categories. This higher level
of classification is made possible by  . schemas

Notice that the dataset types are the same, while the schemas are different

The Shelf Module contains several schemas. Some of the schemas used in the Shelf Module are  , coast line ba
,  ,  ,  . You can define the schema of a dataset in the projectse line limit line seabed surface sediment thickness

by right clicking it, and selecting   in the pop-up menu. The choice of a dataset´s schema controlsset schema
which commands you see in the pop-up menu when you right click the dataset. You may create your own
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schemas as well as edit existing schemas by selecting   under edit in the main menu. You can also editschemas
the commands associated with the schemas.

Commands

Commands are operations which can be performed on a dataset. Commands can for example be used to
display a dataset in the display window, or to generate new datasets. You can even create your own scripted
commands to cater to your specific needs. You execute a command by right clicking the dataset or folder you
want to run it on, and then selecting the relevant command in the pop-up menu.

Commands have two execution modes:   and  . If the execution mode is set to   theDirect Interactive Interactive
commands editor with the front menu will be displayed when you execute the command. This allows you to
adjust various settings that define how the command works. Depending on the command, the menu will consist
of different input settings from simple display settings to complex manipulation options. If the execution mode is
set to   the command will execute with the last active input settings for the command. It is possible to seeDirect
the underlying settings for any command by right clicking it in the   and selecting  .Note that someToolbox Edit
commands does not require input parameters and will therefore display the underlying code when running it in In

 mode.teractive

All commands have a front end panel, and most of them have settings that may be customized.

 
 An example of a command front end panel

Commands can be stored in three categories:

Item commands
Schema commands
Shared commands.

You will find the commands sorted into the different categories in the   or on the right-click menu of aToolbox
dataset or a folder. Commands can also be put together in sequence in   to perform visualizations orWorkflows
data operations.

Item commands

An item command is associated with a single dataset or folder in the project. Item commands are stored along
with the project. Therefore, if a project is transferred the item commands will transferred as well. Item commands
typically contain settings that pertain specifically to the dataset to which it belongs.

Schema Commands
A schema command is stored with a schema. All datasets or folders using the same schema share these
commands, which also means that editing these commands will affect all the datasets using this schema. The
schema commands are listed on the right click menu and in the   under  . Toolbox Schema commands

To see if a command is set to  or  mode, look behind the command name. If there areDirect Interactive

ellipsis ( ) behind the name, the command is set to  mode.... Interactive
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Exercise

Get familiar with schema commands

Right click the different datasets in the project, and see how the right click menu changes from
schema to schema.

Shared Commands
Shared Commands are commands which are shared with all datasets and folders. These commands are always
available and listed in the   under  . Toolbox Shared commands

 

Default Commands
The default command is the command that is executed when you tick the box next to a dataset in the project.
By default a dataset will have one of the schema commands as a default command. This can however be
changed to any command.

 

Exercise

Change the default display for seabed surfaces

The seabed surfaces has a default command "Map sea" or something similar.

Click on the  datasets in the  folder.Seabed Grids
In the right-click another command (i.e ) and selectToolbox LOD Grid Display  Set as default
command
Tick the checkbox next to the  dataset and notice that the new command is executed.Seabed

-

Tip

The  check box lets you decide which commands should be available in the right clickPin to Menu

menu, so it is easy to keep organized.  Try to experiment with this option to manipulate the right click

menu.
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Geodetic settings

In Geocap it is the responsibility of the user to secure that data have the correct   and Datum Coordinate system
, also called a  or . Datasets with the same geographical location but with differentProjection   Geodetic settings
coordinate system will not be displayed in the same location in the graphical window. Thus, you will need to
convert one of the datasets to the other coordinate system.

 

Exercise

View the geodetic settings of a dataset

Right click any dataset in your project and click Properties
Click on the tab Geodetics 
Observe the Geodetic settings of the dataset
Read the warning message
Click Close

You will learn how to convert datasets to other projectons later in this tutorial.

Color Tables

Geocap comes with a set of predefined color tables which can be seen in the toolbox. These color tables are of
course customizable, or you can create your own color table from scratch. By default the color tables shown in
the lower right corner of Geocap will be used to display a dataset. You can change these color tables by
selecting one of them, right-click another color table in the toolbox and select  . Activate You can also drag color
tables from the toolbox and drop it onto a displayed dataset in the graphical window.

Exercise

Change the color table on a seabed surface

Visualize a seabed surface
Click on the tab in the Color Tables Toolbox

,  and  one of the color tables on the seabed surfaceClick drag drop

Sticky Surface

Geocap has a concept where any surface can be set to be  . When a surface is sticky, data like points,sticky
lines or images may be displayed onto that surface. This is mainly done by re-sampling lines and displaying
them a little bit above the sticky surface. When a surface is activated (or set) as a sticky surface, it is copied to
workspace under the name  .sticky_surface

Exercise

Display data on the Sticky Surface

Right-click on a Seabed surface dataset and select  Set as sticky surface
Select a line, e.g.  in your project.Sedimen Data > ATL-99-1
In the Toolbox under  right-click  and click .Commands > Schema commands Display Edit
Check the  and press .Glue to Sticky Surface Execute
Investigate the line display
Uncheck the  and press  again and observe the difference.Glue to Sticky Surface Execute

Warning
Note that points and lines displayed onto a sticky surface are displayed without their original z-values,

and this may not be what you intend to do when displaying a foot of slope point or a bathymetric line.

Keep that in mind.
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Toolbar

 - Will cancel any mouse action that is started but is regretted and should be ended without any operation.

 - Start a mouse action that when clicked on a graphical object will delete that object.

 - Start a mouse action that when clicked on a graphical object can set   parameters for thatappearance
object. The   parameters are:  .appearence Opacity, Reflection, Diffusion, Ambience

 - Start a mouse action where the user is supposed to click on a surface that is map with   values. Thescalar
mapping range of the scalar values according to the color table can then be adjusted.

 - Start a mouse action that when clicked on a graphical object will highlight the corresponding data object in
the project.

 - Start a mouse action where the user can click and draw a rectangle around displayed data and Geocap
will list all dataset names and locations.

 - Will delete all graphics in the current viewport or window (if the window holds only one viewport). The
corresponding references to actors in the project are deleted. Frequently used in free interactive work.

 - Will delete the last graphical object (also called and actor) that is displayed. Frequently used to erase a
graphical object that shall be removed.   Redisplaying data from the project using the same command willNote:
erase the previous corresponding actor.

 - Will set the graphical window in 2D mode; i.e. only   and   is allowed. The view direction (x, y or z)pan zoom
depends on the corresponding setting. In 2D mode the left button on the mouse is used for immediate cursor
response for instance in digitizing

 - Will set the graphical window in 3D mode;  ,   and   is enabled. The default 3D modepan zoom 3D rolling
renders in  ; i.e. parallel lines are not parallel on the screen, but shows a perspective. perspective view

 - Will turn the z direction of the graphical window upwards; i.e. the positive direction of the z axis points
upwards.

 - Will turn the z direction of the graphical window downwards; i.e. the positive direction of the z axis points
downwards. This is the default case because most surfaces are below the zero level, but still have positive z
values.

 - Will show the graphical window as a frame box. It is important to use this icon to check the graphical
window or whenever some display comes out weird if the display algorithm uses the graphical window to set
display parameters.

 - Will draw default axes for all visible axes directions. No tick marks are display for simplicity, but the exact
location of an annotation position starts at the beginning of the annotation.

 - Will open a   which is a convenient menu for navigating a 3D graphical scene. To someNavigator
(especially newbies) it can be difficult to use the mouse buttons to orientate the graphics. Be aware that rotation
is around the   which also can be set by pointing the cursor mouse at a any location on a solid objectfocal point
and push keyboard  .x

 - Will zoom in towards the  . The graphical window is not changed, although the graphical framefocal point
may lie out the visible part of the screen.

 - Will zoom out from the  .focal point

 - Will  . This icon also contains sub-icons for viewing in other directions.View from above

 - If several windows are created on the same  , this icon connects the selected windows to the sameTab
visual camera. Very useful when different surfaces that shall be compared are displayed in separate windows
that are connected and show the same under all graphical movements.
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 - Will show the   that allows for a quick way to create viewports inside a window. The numberviewport menu
and layout of the viewports are determined by just double clicking on the lower right frame in the veiwport menu.
If the viewports are connected they can also by used for simultaneously display of surfaces or features that shall
be compared. 

 - Enables the light source to be moved around in the graphical scene. Will create shadows and highlight
features. Usefull for presentation graphics and detailed studies of special structures.

 - Will scale the graphical scene with all its actor up or down. Very important for selecting a good view. The
scaling should also preferable be set in the   so that the preferred view comes up when loadingProject Settings
a project.

 - Will show up a 2D compass in upper right that follows the rotation of the graphical window. Another click
on the icon will remove the compass.

 

Exercise

Try out the different tools on the toolbar

Try out the different tools.

Keyboard shortcuts

Geocap has several   or  . Go   shortcuts to bring up a list. Akeyboard shortcuts hotkeys Help > Keyboard
selection of the most important keyboard shortcuts:

Key Explanation Key Explanation

j Snap to any point on a displayed line. + Zoom in.

o Toggle color code for last used map command
on/off.

- Zoom out.

r Rescale to all graphical elements. 2 Toggle graphics to 2d mode.

s Turn graphics into surface mode. 3 Toggle graphics to 3d mode.

v Value of height/depth (z coordinate) from
graphics.

3 Toggle stereo view on/off when stereo is
activated.

w Turn graphics into wire mode. y Cursor point is set at the surface of the
graphical element.

x Setting the focal point. The graphics will rotate
around this point.

z Zoom by drawing a rubber band with left
button on the mouse.

 

 

Exercise

Try the different keyboard shortcuts

Visualize a seabed surface and test all the above mentioned keyboard shortcuts.

When using or to snap to lines or surfaces, Geocap will report what you have snapped to in the lowerj y 

left corner.
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G. Charts

Introduction

Working with large amounts of data can be cumbersome. Thus, Seafloor lets you divide your survey area into
smaller areas called charts. These charts are populated with multibeam soundings and you can then perform
operations like gridding and points classification on ea

Exercises

Create a master chart
Create sub-charts
Populate charts with soundings
Show properties for each chart
Display chart frames
Display chart soundings

Creating and populating charts

Exercise

Create a master chart

Click the  tab in the Chart commands Seafloor Main Menu
Click Create and Modify Chart
In the  type in  as Create Single Chart Master Chart Chart name
In the  tab click Create Single Chart Scale to Survey Data
In the dialog that pops up, tick the  folder checkbox and click . The menu shouldMultibeam OK
now look similar to the one below:

Click  to create the chart and click  in the dialog that pops up.Execute OK

You have now created a master chart for the whole area of your survey, and we are now going to create
sub-charts for this master chart.
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Exercise

Create sub-charts

Click the  tab.Create Matrix of Charts
Make sure that your master chart has been selected in the  section of the menu.Master Chart
Keep the name  with extension set to . This will give the chart name SubChart- Automatic Sub

 and so on.Chart-1
Make sure that  has been selectedBy number of rows and columns
Set  and  to . Note that the  and  of the charts will automaticallyRows Columns 2 Height Width
change when you change the amount of rows and columns.
The menu should now look similar to the one below:

Click Execute
You will be asked if you want to create 4 (2x2) charts. Click Yes
Click  in the dialog that pops up.OK
Click  on the  menuOK Create and Modify Chart

You now have one  folder and several  folders inside the  folder.Master Chart SubChart-X 2. Charts

After the you have created the charts the folders will only contain a frame, thus we need to extract the multibeam
soundings and populate them into the frames.

It is also possible to generate charts along a line, by drawing a rectangle, by specifying a certain size or

by specifying coordinates.
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Exercise

Populate charts with soundings

Click  on the  tab in the Extract Soundings Chart commands Seafloor Main Menu
In  type in  m to avoid any loss of data between the charts. (Dependent on theMargins 5
gridding increments.)
Tick the  checkbox.Multibeam
Select all the  in the  section.SubChart-X Chart Name

Click  and the extraction process will start.Execute
Click  in the dialog the pops up.OK
Click  on the  menu.OK Extract Soundings

Each sub-chart will now contain a dataset named  in addition to the  datasetSoundings Frame

-
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Chart properties

Exercise

Show properties for each chart

Click  on the  tab in the .Show Chart Properties Chart commands Seafloor Main Menu

Observe that the list contains a row for each chart. Take a closer look at the different columns.

Showing Chart Properties

 

Displaying chart data

Exercise

Display chart frames

Click  on the  tab in the .Display Chart Data Chart commands Seafloor Main Menu
Make sure that only  is checked in Frame Select Data Object
Select all the sub charts.
Make sure that  is checked.Scale to selected charts
Click Execute
Check the  box to see the name of the charts.Chart Name

 

 

Exercise

Display chart soundings

Open the  menu againDisplay Chart Data
Check the following boxes; , , ,  aFrame Soundings Use colour range Use same range for all
nd Use LOD
Select all the sub charts
Click Execute
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H. Gridding Files and Charts

Introduction

Gridding can be performed directly on processed multibeam data or on separate charts. Seafloor offers several
gridding algorithms, filtering and smoothing. Filtered points can be saved in the project.

Exercises

Gridding multibeam data
Displaying the result grid
Gridding charts
Display Chart grids
Display rejected soundings
Merge Chart surfaces

-
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Multibeam

Exercise

Gridding multibeam data

Right click the  folder under , select  anMultibeam 1.Survey Data Gridding Multibeam Data...
d the gridding menu will pop up.

Multibeam gridding menu
Keep  as the gridding algorithm.Weighted Average
Change  to  and keep the  option.X increment 3 Use YInc=XInc
In the  tab set  to  and change the  to .Algorithm Parameters Search radius 5 Unit Metric
Keep the  as Weight function 1/D
Select all the survey lines (click one and use ctrl + a).
Click  and the gridding process will start.Execute
When the gridding has finished a report window will pop up, showing the details of the gridding
process
Click OK

The grid is saved as  in the  folderSurface_WeightedAverage 1. Survey Data / Multibeam

Exercise

Displaying the result grid

Right-click the  grid in the  folder andSurface_WeightedAverage 1. Survey Data / Multibeam
select Zoom to Data
Right-click the  grid again and select Surface_WeightedAverage LOD Grid Display

-
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Charts

Exercise

Gridding charts

Select the  tab in the Chart commands Seafloor Main Menu
Click Gridding Chart
Keep  as the gridding algorithm.Weighted Average
Change  to  and keep the  option.X increment 3 Use YInc=XInc
In the  tab set  to  and change the  to .Algorithm Parameters Search radius 5 Unit Metric
Keep the  as Weight function 1/D
Check the  boxFilter input points
Click the  tabFilter and re-grid
Check the  box, set  to  and set  Save filtered points Filter type Standard deviation Shallow-
and  to .Deep factor 3
Select all the  (click first and use shift + click on last).SubCharts-X
Click  and the gridding process will start.Execute

When the gridding has finished, each sub chart folder will have four new datasets: , Seafloor Soundi
,  and .ngs Soundings_Accepted Soundings_Rejected

 

 

Exercise

Display Chart grids

In the  tab in the , click Chart commands Seafloor Main Menu Display Chart Data
Make sure  box is checkedFrame
Check the  box and make sure  and  is checked.Seafloor Use same range for all Use LOD
Make sure the  is checked.Scale to selected charts
Select all the  (click first and use shift + click on last).SubCharts-X
Click Execute

 

 

Exercise

Display rejected soundings

Click the  icon on the main toolbar to remove all graphics
Go to the folder  in the projectSubChart-1
Right click the  dataset and select Seafloor Zoom to Data
Right click the  dataset again and select Seafloor LOD Grid Display
Right click  and select Sounding_Rejected Display Points

You will now see the points that were filtered away with the standard deviation filter during the
gridding process.
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Exercise

Merge Chart surfaces

Right-click the  folder and select 2. Charts Merge Surfaces

Click the  button and select the  folder to save the merged2. Charts / Master Chart
surface in.
Keep teh default options for  and Merge surfaces Specify surface increments
Select all the subcharts and move them over to the right column. The menu should now look
like the image below:

Click  and a dialog will pop up asking if you want to merge 4 charts.Execute
Click Yes

A report window will pop up when the merging has been performed. The merged surface will be
saved in the  folder.2. Charts / Master Chart
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I. Multibeam Depth Editing

Introduction

Seafloor enables you to perform both   and  of sonar data.automatic depth filtering manual editing

The  offers three filters:automatic depth filtering

A threshold filter which will remove all points shallower or deeper than the threshold.
An angle filter which measure the angle between neighbour points on the same ping and eliminate those
exceeding a certain value.
A surface filter which can calculate the standard deviation for all points and remove points outside, e.g. 2
times the standard deviation.

The  is performed by the  (Multibeam Editor).manual editing Point Cloud Editor

 

Exercises

Automatic Threshold filtering
View the result from the automatic Threshold filtering
Automatic Surface filtering
View the result from the automatic Surface filtering
Revert flagged points from automatic filtering
Manually edit a single multibeam survey line
Display removed points and undelete them again
Manually edit multiple multibeam survey lines

 

  

Automatic Filtering

Exercise

Automatic Threshold filtering

Right click the  folder inside  and select Multibeam 1. Survey Data Multibeam Depth Filtering
In the menu that pops up, check the  boxTreshold filter
To find the min and max, click the  button.Show Survey line properties...
Check both  and  and type in theRemove shallower than depth Remove deeper than depth
min and max value.
Leave the  box unchecked for now.Angle filter
Leave the  box unchecked for now.Surface filter
Select one or several of the survey lines.
Click Execute

In the report that appears you can see how many points that were flagged in each multibeam file.

Note that none of the methods will actually delete the points. They will only be flagged as deleted, which

means you can go back to the original, unfiltered version at a later stage.

The editing methods described in this section are also applicable on Point Cloud (XYZ) data.
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Exercise

View the result from the automatic Threshold filtering

Open the  dialog.Display Multibeam Data
Display (some of) the lines which have been filtered.
Click the  button in the lower part of the window.Open Point Flag Visibility Filter

The  dialog is opened.Point Flag Visibility Filter

Click the  button on the menu bar.Add
The dialog for adding filter is opened.

Select, for instance, the  entry and click .ThresholdShallowerFiltered OK
Repeat clicking the  button. This time, select the  entry andAdd ThresholdDeeperFiltered
click .OK
In the  dialog, tick the  checkbox for both filters.Point Flag Visibility Filter Color
Click the  button and set individual colors for the filters.Edit Color

The Threshold filtered points are now displayed together with the accepted points.
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Exercise

Automatic Surface filtering

Right-click the  folder inside  and select Multibeam 1. Survey Data Multibeam Depth Filtering
In the menu that pops up, check the  boxSurface filter

Click the  icon and browse in the surface you generated in the Gridding chapter.
Select  as Standard Deviation Filter type
Select a  and a Shallow factor Deep factor
Select one or several of the survey lines.
Click Execute

 

 

Exercise

View the result from the automatic Surface filtering

To view the result from the automatic Surface filtering, the method is the same as for Threshold
filtering.

Open the  dialog.Display Multibeam Data
Display (some of) the lines which have been filtered.
Click the  button in the lower part of the window.Open Point Flag Visibility Filter
Click the  button on the  dialog menu bar, and select the Add Point Flag Visibility Filter Surfa

.ceFiltered
In the  dialog, tick the  checkbox for  (andPoint Flag Visibility Filter Hilight SurfaceFiltered
also tick  for the threshold filters).Hide

The points that are displayed are the ones that got flagged by the surface filter.

 

 

Exercise

Revert flagged points from automatic filtering

Right click the  folder in your project and select Multibeam Revert flagged points
Check the flags you want to revert
Select the  you want to revert fromSurvey Lines
Click Execute
Click  when asked about reverting flags for 6 filesYes

After the processed has finished you are presented with a report telling you how many points were
reverted for each flag for each survey line.

-

To remove the accepted points, tick the  checkbox for .Hide All Points
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Manual Editing

The  lets you manually edit points in both 3D and 2D. Removed points will be flagged asPoint Cloud Editor
deleted, but can later be retrieved.

The Point Cloud Editor menu

The menu has two parts. A  part and an  part.Selection Action

Selection
You have to select a set of points before you can perform an action on them. There are five different ways to
select points:

Rubber band select (shortcut key ) - Click and drag a rectangleR
Lasso select (shortcut key ) - Digitize a polygon (double click to close)L
Threshold select - Select a  or  value.Deeper Shallower
Expand selection to ping - First use one of the other tools to select points. Then click the this tool to select
all the other points in the corresponding ping(s).
Flag select - Select by flag type

After selection the points will be visualized in white.

Action
After a set of points have been selected it is possible to perform several actions on them:

Delete them (shortcut key ) - The points are only flagged as deletedDelete
Undelete them
Flag them according to a userndefined flag
Edit on the selected points

By clicking  it is possible to make a new selection only within the previous selection. This makes itEdit Selected
easier to narrow in on points/noise you want to delete.

The green arrows allows you to redo or undo previous step, while  will allow you to make all the pointsEdit All
available for editing.

Note that by clicking  ( ) or  ( ) the 3D window will be locked untilRubber band select R Lasso select L

you have finished the selection. This means that you will not be able to rotate or pan during the selection

process.

It is possible to deselect parts of a selection by changing the drop down list to  Remove from selection

and then perform another selection within the previously selected points.

You can also use the  icon to remove the selection.Clear selection
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Exercise

Manually edit a single multibeam survey line

In the  folder, right click on of the Multibeam Survey datasets and select Multibeam LOD
Points Display
Click on the small triangle next to the Multibeam Survey dataset to expand all its elements.
Right click  under the Multibeam Survey dataset and select Multibeam Sonar Edit
Click the  iconRubberband Select
In the graphics window, click and drag the rubber band around an area where there are spikes
you want to remove.
Notice that the selected points are displayed in white.
Click  and notice that the points are removed.Delete
Continue to select and flag points until you have removed all the spikes.
Click OK

 

 

Exercise

Display removed points and undelete them again

On the  tab in the  click .Multibeam Sonar Seafloor Main Menu Display Multibeam Data
Click .Open Point Flag Visibility Filter
Click .Add
Select  and click .UserDeleted OK
Tick the  box for the  flag and observe that the points you deleted areHighlight UserDeleted
now displayed in red.
Open the  again.Multibeam Editor
Press  on your keyboard and draw a rectangle around all (or some) of the red points that youR
want to undelete.
Click  and observe that the points are now display normal again.Undelete

 

 

Exercise

Manually edit multiple multibeam survey lines

Click the  on the main toolbar to clear the screen.
On the  tab in the  click .Multibeam Sonar Seafloor Main Menu Display Multibeam Data
Select all survey lines and click Execute
On the  click  and select .Seafloor Main Menu Edit Multibeam Editor
Click on  and create a large selection area around some spikes you wantRubberband Select
to remove.
Click . Notice how all points outside the selection are are now transparent whileEdit Selected
the selection area is displayed in "normal" colors again.
Click  and make sure to select an area containing both transparent and "normal"Lasso Select
points. Notice that only the "normal" points are selected.
Repeat the last two steps until you have narrowed into the spikes you want to remove.
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J. Navigation Processing and Editing

Introduction

Seafloor enables you to perform both automatic processing and manual editing of navigation data. The
automatic navigation processing offers two methods:

A spike filter which will remove points which seems to have a speed faster than a certain value.
Moving average filter which smooths data according to a given "point window" length.

Manual editing is possible by using the  menu, which is a general menu who combines data tables,Table View
2D view and 3D view.

Exercises

Automatic navigation processing
Manual editing of navigation data

 

The delete methods will actually remove the points from the navigation line, while the smoothing

operation will save the original positions, which means that you can return to the unsmoothed version at

a later stage.
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Exercise

Automatic navigation processing

Right click the  folder inside  and select .Multibeam 1. Survey Data Navigation Processing

In the Navigation Processing dialog check the  boxSmooth
Set Window length to , and iterations to .5 1
Check that the smoothing mode is .Apply
Select one or several of the survey lines.
Click Execute



Page 46

1.  

2.  
3.  
4.  
5.  
6.  
7.  

8.  

9.  
10.  

11.  
12.  

Exercise

Manual editing of navigation data

In the project click on the small triangle next to a Multibeam Survey dataset to expand all its
elements.
Right click  under the Multibeam Survey dataset and select .Navigation Table View
Right click the  data object and select .Navigation Display
In the  table view menu, click the  button.Navigation 2D Plot>>
Check the  box.Display marked points
Expand the window to better see the table and the graphics.
Check the data columns in the data set.

In the graphics window, hold the  button and click and drag the rubber band around theShift
points you want to investigate.
Notice that the selected points are displayed both in the table and in the 3D graphics window.
Use the buttons  and  toRubber band mark (3D window) Rubber band unmark (3D window)
select and de-select points.
To enable for deleting points you must click the  button.Edit Mode
Click  to close the menu.Close
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K. The Cross Section Window

Introduction

Geocap Seafloor can compare data from different datasets by viewing the data in a cross section view. By
changing the visualisation attributes it is possible to identify problems in the data. In this exercise the data will be
visualised in both 3D and 2D.

 

 

Exercises

Compare two overlapping survey lines against each other
Edit the color and size of points in the cross section window
Edit the size, direction and position of the profile

 

Exercise

Compare two overlapping survey lines against each other

Make sure you have displayed two overlapping survey lines in the graphics window, using the same
method as in one of the previous exercises. For instance, display the two lines 0000_20060112_1301

 and .56_Simrad_echo.all 0001_20060112_131814_Simrad_echo.all

In the Geocap main window, click  . The crossWindows > New > Cross Section Window
section window will appear at the bottom of the screen.

In the cross section window click the arrow to right of the  icon, and open the menu.

Click the   entry in menu.Digitize cross section
Create a profile over the overlapping area, by digitizing two points in the graphics window
using your left mouse button.

You should now see the multibeam soundings along the profile in the cross section window. You can
zoom using your right mouse button, use the left mouse button to pan and the mouse wheel to scale
the z-direction.

 

 

  

The Cross Section Window can be used to check calibration of the multibeam survey lines.

Points at a certain distance on both sides of the cross section are projected on to the cross section

window. You can decide this distance by editing the .Point projection distance
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Exercise

Edit the color and size of points in the cross section window

In the cross section window, right click one the name of one of the survey line and select .Edit

In the dialog that pops up, change the  to another color than the default.Point color

You should now be able to distinguish the points on each line from each other.

Try out different display options in the  dialog.edit

Exercise

Edit the size, direction and position of the profile

In the graphics window click on the profile frame. You should now see one sphere in each
corner of the profile.

Click and drag one of the spheres to re-size or change the angle of the profile.
Click in the middle of the profile and drag in order to move the whole profile.
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L. Vessel Configuration Manager

Introduction

Multibeam data are imported by the command . As a part of the import the makeImport Multibeam Sonar Data
and vendor of the multibeam echosounder is registered. Vital information like the mount parametres are read
from the datafiles and will be saved in a Vessel configuration file in the project. Multibeam files with different
installation parameters will have reference to different vessel configuration setup.

Exercises

Open the Vessel Configuration Manager
Check all parameters
Change Roll parameters

 

Exercise

Open the Vessel Configuration Manager

In the , go to Seafloor Main Window Edit > Vessel Configuration Manager...

Right click one of the  and select Vessel configurations Edit
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Exercise

Check all parameters

Click the  tab to see the information.Mount parameters
Click the  tab to see the information.Processing parameters
Click the  tab to see the information.Standard deviation parameters

 

 

Exercise

Change Roll parameters

Click the  tab.Mount parameters
See the Roll angle value, .-0.640
Change the value to .-2.640
Click OK
Also click  in the Vessel Configuration Manager dialog.OK
Redisplay the survey lines  and 0000_20060112_130156_Simrad_echo.all 0001_20060112_13

.1814_Simrad_echo.all
Verify the changes in the roll.
Again, open the Vessel Configuration Manager dialog.
Click the  tab.Mount parameters
Click the  button and verify that the Roll angle is reset back to .Use file values -0.640
Click OK
Also click  in the Vessel Configuration Manager dialog.OK
Redisplay the survey lines  and 0000_20060112_130156_Simrad_echo.all 0001_20060112_13

.1814_Simrad_echo.all
Also try the Roll angle .-0.300
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M. Import Sensor data

Introduction

Seafloor can import and replace the sensor data of the selected multibeam survey lines from ASCII formats. 
Sensor types which can be import replaced:

Navigation
Tide
Velocity
Heave
Roll
Pitch

Exercises

Check available ASCII formats
Import Tide file
Import Navigation file

 

Exercise

Check available ASCII formats

Right click the  folder under  and select Multibeam 1. Survey Data Import ASCII Sensor...

Click the  icon and open the help menu.
Check the available .Sensor type
Click OK

 

 

Exercise

Import Tide file

Right click the  folder under  and select Multibeam 1. Survey Data Import ASCII Sensor...

Click the  icon and browse for the tide file.
Make sure that  is selected in under .Tide Sensor type
Select one or several of the Survey lines.
Click Execute

 

 

Exercise

Import Navigation file

Right click the  folder under  and select Multibeam 1. Survey Data Import ASCII Sensor...

Click the  icon and browse for the navigation file.
Make sure that  is selected in under .Navigation Sensor type
Select one or several of the Survey lines.
Click Execute
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N. Points Classification

Introduction

Seafloor can automatically classify points into the following categories:

Shoals
Deeps
Ridges
Saddles
Valleys

The user can specify the search radius and angle, where applicable. The points will be saved as separate
datasets in a  folder under each chart.classification

Exercises

Classify points
Display classified points

 

Exercise

Classify points

On the  tab in the , click .Utilities Seafloor Main Menu Point Classification

Check the box for  and the box for .Shoals Deeps
Note all the boxes for the different classification types.
Specify the search radius, for instance , in the corresponding tabs for the two data types.50
Select the main chart.
Click Execute

The resulting datasets can be found in the  folder under the chart.classification

This excercise expects that the project already contains at least one chart and a corresponding Seafloor

surface.
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Exercise

Display classified points

Browse to the  folder for the actual chart.classification
Display the dataset  by right click and select shoals_50 Display Points
Display the dataset  by right click and select deeps_50 Display Points

Repeat the last to excercise by changing the search radius. Also try to check the box Find corresponding
.points in Soundings
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O. Export Data

Introduction

Seafloor lets you export Polygons, Points, Surfaces, Hill shades, Contours.

There is a wide range of export possibilities and formats such as, Shapefiles, ASCII-formats, GeoTiff,
Irap-formats and VTK.

Exercises

Export surfaces as Irap ASCII
Export surfaces as points
Try different export formats for surface export
Export all soundings
Export contour lines to ASCII
Export contour lines to KML
Export contour areas
Export Hill Shade as GeoTiff

 

Surfaces

Exercise

Export surfaces as Irap ASCII

In the  tab in the , click Utilities Seafloor Main Menu Export Chart Data
Click the  tabSurfaces
Select all the sub-charts
Select  as the Irap ASCII Export Format

Click the  icon and select a directory to save the files.
Leave the  blank. This will cause your files to be named  File name "Seafloor_SubChart-1.ifgr"
and so on.
Click Execute

Exercise

Export surfaces as points

In the  tab in the , click Utilities Seafloor Main Menu Export Chart Data
Click the  tabPoints
Check the  boxSeafloor surfaces as points
Select all the sub-charts
Select  as the ASCII Column Export Format

Click the  icon and select a directory to save the files.
Leave the  blank. This will cause your files to be named  File name "Seafloor_SubChart-1.asc"
and so on.
Click Execute

Exercise

Try different export formats for surface export

Repeat the previous exercise, but this time use  and/or  as export format.KML Shape
Try opening the files in another software that can read these files e.g. Google Earth, ArcGIS,
QGIS etc.
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Soundings

Exercise

Export all soundings

In the  tab in the , click Utilities Seafloor Main Menu Export Chart Data
Click the  tabPoints
Check the boxes for ,  and Soundings Soundings_Accepted Soundings_Rejected
Select all the sub-charts
Select  as the ASCII Column Export Format

Click the  icon and select a directory to save the files.
Leave the  blank.File name
Click Execute

This will export three datasets for each sub chart.

Contours

Exercise

Export contour lines to ASCII

On the  tab in the , click Utilities Seafloor Main Menu Export Contours
Check that the  radio button is ticked.Export as: Contour Lines
Select the .Master Chart
Set  to .Contouring method Incerement
Set  to .Increment (m) 1.00
Also consider the parameters , , and Use min level Use max level Invert Z
Check the  option .Save to File and project
Select  as .ASCII Column Export Format

Click the  icon and select a directory to save the files.
Enter  as a prefix for for the file names.1m
Click Execute
Verify that the files are saved on the prefered folder on the disk.
Verify that the selected chart now have a  dataset saved in the charts' folder.Contours

Exercise

Export contour lines to KML

Repeat the exercise above, but this time select  as the export format.KML
Try to open the exported file in Google Earth

Note that Google Earth will have problem loading files with large amounts of points. You should try to

limit the amount of points to less than 50 000. Right-click a grid and select  to see theProperties

amounts of points in a grid.

To reduce the amount of points you need to create grids with coarser resolution or create smaller sub

charts.

Geocap exports KML-files with default settings (yellow pin for points). If you want to change the visual

settings for the KML file, you can use text editors like Emacs or Notepad ++. Read more about .KML

https://developers.google.com/kml/documentation/kml_tut
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Exercise

Export contour areas

On the  tab in the , click Utilities Seafloor Main Menu Export Contours
Check that the  radio button is ticked.Export as: Contour Areas
Select the .Master Chart
Set  to .Contouring method Incerement
Set  to .Increment (m) 5.00
Check the  option .Save to File only
Select  as the .Shape Export Format

Click the  icon and select a directory to save the files.
Enter  as a prefix for for the file names.5m
Click Execute
Verify that the files are saved on the prefered folder on the disk.

Hillshade

Exercise

Export Hill Shade as GeoTiff

On the  tab in the , click Utilities Seafloor Main Menu Export Chart Data
Click the  tabHill Shade
Set  to Altitude deg: 45
Set  to Azimuth deg: SouthWest
Set  to Z Scale: 10
Select the Master Chart
Check the  option .Save to File and project
Select  as the .GeoTiff Export Format

Click the  icon and select a directory to save the files.
Enter  as a prefix for for the file name.45deg_SoutWest_Zx10
Click Execute
Verify that the file is saved on the prefered folder on the disk.
Right-click the  dataset in the  folder and select HillShade Master Chart Display
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P. Image Georeferencing

Introduction

This tutorial will guide you through the process of georeferencing a map. To georeference a map or image you
need at least 3 tie points. These points should cover as much of the map as possible. In this tutorial we will use
a sea chart from the Oslofjord. This chart has some marked positions referenced in WGS84, UTM Zone 33, as
tie points.

Exercises

Import an image into your project
Georeference an image
Convert an image to another UTM zone

 

Exercise

Import an image into your project

Create a  folder (i.e. a folder with schema Generic) and rename that folder to Generic My
Maps
Right-click the  folder and go to . Browse for the image My Maps Import > Generic sjokart.pn

 (a *.jpg or a *.png).g
Make sure the schema of the image set to .Image Data

A map about to be georeferenced.

It is important to understand what coordinate system and datum the map is in - or make a qualified guess. Note
also that you should be able to determine the coordinates of your tie-points, here encircled in red.
The tie-points can be find in the text file coordinates.txt:
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Coordinate system: WGS84, UTM zone 33
Lower left: East: 241073.89 North: 6599354.87
Upper left: East: 240904.64 North: 6601351.49
Upper right: East: 245955.69 North: 6601663.55

 

 

Exercise

Georeference an image

Use the Georeferencing wizard to georeference an image. Follow the step-by-step procedure below.

Georeferencing step by step

Make sure the image is selected in the project and right-click and select the  command inGeo Reference
the pop-up.
(If it is not visible you will have to open the  by ).Toolbox View > Toolbox

Then the dialog for setting the coordinate system and a window containing the image is shown:

Set geodetic properties of the chart: WGS84, UTM Zone 33 N

Click .Next

Set  to .Method: Scale and Translate

Set  to XY.Tie point Coordinate Format:
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Type in the  =  and  =  for the first tie point, click  and click on theX 241073.89 Y 6599354.87 Image pick
corresponding point in the map.

Change to .Tie point 2

Type in the  =  and  =  for the second tie point, click  and click on theX 240904.64 Y 6601351.49 Image pick
corresponding point in the map.

Change to .Tie point 3

Type in the  =  and  =  for the third tie point, click  and click on theX 245955.69 Y 6601663.55 Image pick
corresponding point in the map.
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Evaluate the result. The  represents the accuracy of the georeferencing. The value should notPixel error
exceed more than 1 pixel on each point.

Click Finish. 

Now the image must be transformed from  to .UTM Zone 33 UTM Zone 32
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Exercise

Convert an image to another UTM zone

From the image sjokart, right-click and in the pop-up select All Commands > Shared
Commands > Operations > Convert to UTM. (If it is not visible you will have to open
the Toolbox.)

Set the new geodetic properties for the image: WGS84, UTM Zone 32 N
Specify how to save the new image for e.g. Replace, Copy in input folder or Specify na
me and where to store it.
Then click Execute.
Display the new image in the main graphic window, and also display the multibeam data
or the surface created from the multibeam data.
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Q. Workflows

Introduction

A workflow in Geocap is a way of combining datasets and actions or visualizations in sequence to produce
visualizations, movements and powerpoint style 3D presentations. The Atlantis Project is used throughout this
tutorial.

Exercises

Examine the workflows provided in the Atlantis_Mini project.
Create a new workflow

 

Exercise

Examine the workflows provided in the Atlantis_Mini project.

In Geocap, click , and browse to the Atlantis_Mini folder, then open the theFile > Open > File
sub-folder called .Workflows
Double click on the file called  to open it, or single click to highlight itsample_workflow.gwf
and then click, . This will open the workflow below the project.Open
Examine the contents of the workflow items by clicking on the triangles next to the root folders.

Click on the   icon and then click on the Go to first executable element Execute next

  icon. This will display the seabed and land.element

Click on the   icon again and notice that the 2500m isobath isExecute next element
displayed.

Continue clicking on the   icon until you reach the end of theExecute next element
workflow and observe how different elements of the Atlantis_Mini project are displayed.

Note that the user may also execute each element one at a time by right clicking on the command and

choosing .Execute
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Exercise

Create a new workflow

Workflows are saved as single files on disk with file extension * , (Geocap Workflow). A good idea.gwf
may be to create a folder in your project called  and put the workflow there.Workflows

Click . Then a browser pops up.File > New > Workflow
Press the  icon to create the first entry. That may also be achieved by aNew Element
right-click .New Element

Select the   command found in the  folder and click .Display Commands OK

Right-click the   command in the workflow and select .Display Edit
In a workflow, you will need to select a dataset from the project. The command usually
requires a dataset to do an action on (such as a type of display).
In your project, select a line and click the green arrow in the Display edit menu.
Choose the display settings you like (color, glue to surface or not, etc.) and click  again.OK
Right click the element in the workflow and choose . Alternatively, click the  icExecute Execute
on.
Examine how your display looks and edit the command if necessary to achieve the results you
want by right clicking on the command and choosing .edit
In order to keep your workflow organized it is recommended to change the name of the newly
added commands from  to something more descriptive like, Display Display Coastline Yellow
which is done by right clicking the command and choosing .Rename
Continue to add different commands to your workflow

Remember to save the workflow by clicking 

Commands may also be copied from ,  and  aShared commands Item commands Schema commands

nd pasted into the workflow.
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R. PostScript Plotting

Introduction

Geocap has a plotting system utilizing the PostScript language. The plotting system enables you to create
scaled maps containing axes, scale bars, contour maps, lines, points, legends and anything else you might
need.

 

Exercises

Open and run a saveset in the plotting system
Explore the different plotting options

  

Note that you will have to install Ghostview and Ghostscript in order to make the plotting system work.
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Open and run a saveset in the plotting system

Exercise

Open and run a saveset in the plotting system

To open the PostScript plotting panel go to *Tools > PostScript Plotting
Click File > Read saveset
Browse for the saveset in the plotting folder under the  project on your disk.Seafloor_Training
Click Generate Draft
When asked if you want to overwrite existing plot, click Continue
When the plotting has finished click File > View Plot in Ghostview

Ghostview should pop up and show your plot.

 

Explore the different plotting options

Exercise

Explore the different plotting options

Try clicking on the different check boxes to open the settings menu for each option.
Try to change some values and re-run the plot to see the changes.
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